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Workshop Overview

1:00-1:15 Introduction to Network Analysis

1:15-1:45 Network Analysis & Visualization in the Humanities

*  Theory, Applications, and Pitfalls.

. Examples In The Wild

1:45-2:15 Collecting, Cleaning & Formatting Data

2:15-2:25 Break

2:25-3:00 Sci2 Tool Basics

. Macroscope Design and Usage.

. Download and run the tool.

. Find basic statistics and run various algorithms over the network.
. Visualize the networks as either a graph or a circular hierarchy.

3:00-3:20 Sci2 Workflow Design: Padgett's Florentine Families - Prepare, load,
analyze, and visualize family and business networks from 15th century
Florence.

3:20-3:35 Break
3:35-4:00 Sci2 Research Demonstration: Mapping the Republic of Letters
4:00-4:30 Q&A and Technical Assistance



Network Analysis & Visualization



What is a network?

University of Southern California
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Source: http://dh2011network.stanford.edu/index.html



What is a network?
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Source: http://dh2011network.stanford.edu/index.html



o What is a network?

*Nodes

id*int label*string totaldegree*int

16 “*Merwede van Clootwyck, Matthys van der (1613-1664)" 1
36 “Perrault, Charles” 1

48 “Bonius, Johannes” 1

67 “Surenhusius Gzn., Gulielmus” 1

99 “Anguissola, Giacomo” 1

126 “Johann Moritz, von Nassau-Siegen (1604-1679)" 6
131 “Steenberge, J.B.” 1

133 “Vosberghen Jr., Caspar van” 1

151 “Bogerman, Johannes (1576-1637)" 25
*DirectedEdges

source*int target*int weight*float eyear*int syear*int
16 36 1 1640 1650

16 126 5 1641 1649

36 48 2 1630 1633

48 16 4 1637 1644

48 67 10 1645 1648

48 36 2 1632 1638

67 133 7 1644 1648

67 131 3 1642 1643

99 67 9 1640 1645

126 16 3 1641 1646

131 133 5 1630 1638

131991 1637 1639

133 36 4 1645 1648

13348 8 1632 1636

151 48 6 1644 1647

. Johann Maritz, von Massau-Siegen (1604-1673)

. Merwede van Clootwyck, Matthys van der (1613-1664)

. Bonius, Johannes
. Perrault, Charles

. Vosberghen Jr., Caspar van

& Bogerman, Johar

. Surenhusius Gzn., Gulielm

. Steenberge, J.B.

. Anguissola,
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- @ Graph Metrics — Nodes / Vertices / Entities

%
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*Degree Centrality - direct connections

‘Betweenness Centrality — # of shortest
paths a node sits between

\

Closeness Centrality — Distance to all nodes

*Hubs / Bridges / Isolates

- Source: http://dh2011network.stanford.edu/index.html
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o :" Graph Metrics — Nodes / Vertices / Entities

. Johann Maritz, von Massau-Siegen (1604-1673)

*Degree Centrality

. Merwede van Clootwyck, Matthys van der (1613-1664)

# Bogerman, Johanne

Betweenness

Centrality

. Bonius, Johannes
. Perrault, Charles
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° A Graph Metrics — Edges / Links / Arcs / Connections / Ties

% 4

*Shortest paths — shortest distance between
two nodes

*Weight — strength of tie

\

Directionality — is the connection one or
two-way?

Bridge — deleting would change structure

- Source: http://dh2011network.stanford.edu/index.html
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° f Graph Metrics — Edges / Links / Arcs / Connections / Ties

g

. Johann Maritz, von Massau-Siegen (1604-1673)

*Shortest paths

. Merwede van Clootwyck, Matthys van der (1613-1664)

& Bogerman, Johannes (1576-1637)

*Weight
. Bonius, Johannes
. Perrault, Charles

Directionality

. Vosberghen Jr., Caspar van

. Surenhusius Gzn., Gulislmus

Bridge




- @ Graph Metrics — Structural

*Clusters — closely connected or similar
nodes & edges

*Clustering coefficient — ‘clique-ness’

N\

Centralization — egocentric or decentralized

Density — ‘spaghetti-ness’

*Average Path Length — wide or narrow

- Source: http://dh2011network.stanford.edu/index.html
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° 3 Graph Metrics — Structural

. Johann Maritz, von Massau-Siegen (1604-1673)

*Clusters

.CI uste ri ng . Merwede van Clootwyck, Matthys van der (1613-1664)
Tall ® Bogerman, Johannes (1576-1637)
coefficient

. Bonius, Johannes

Centralization Q. .

Density

. Vosberghen Jr., Caspar van

.Ave rage Path . Surenhusius Gzn., Gulielmus
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Graph Metrics — Types Of Networks

*Bi-Modal or Multi-Nodal

*Egocentric

= *Dense/Sparse

a

o

- Source: http://dh2011network.stanford.edu/index.html
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*Networks visualized as graphs
Layouts
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= *Tree
-Circular N
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- Source: http://dh2011network.stanford.edu/index.html
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. Macroscope Design and Usage.

. Download and run the tool.
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Network Analysis & Visualization in the Humanities:

Theory, Applications, and Pitfalls



© Uses of Visualization

» Solidifies objects of inquiry
» Exploration

» Discovery

» Trend-spotting

» Evidence

» Audience Engagement

» Engaging public / funding agencies



o | The Importance of Visualization

[Visualization] aim at more than making the invisible visible. [It aspires| to
all-at-once-ness, the condensation of laborious, step-by-step procedures
in to an immediate coup d'vezl... What was a painstaking process of
calculation and correlation—for example, in the construction of a table
of variables—becomes a flash of intuition. And all-at-once intuition is
traditionally the way that angels know, in contrast to the plodding

demonstrations of humans.

Descartes’s craving for angelic all-at-once-ness emerged forcefully in his
mathematics. .., compressing the steps of mathematical proof into a

single bright flare of insight: “I see the whole thing at once, by intuition.”

Lorraine Daston — On Scientific Observation



o Warnings

[HJumanists have adopted many applications such as GIS mapping, graphs, and
charts for statistical display that were developed in other disciplines... such

graphical tools are a kind of intellectual Trojan horse...

Data pass themselves off as mere descriptions of a priori conditions. Rendering
observation (the act of creating a statistical, empirical, or subjective account or
image) as if it were the same as the phenomena observed collapses the critical distance
between the phenomenal world and its interpretation, undoing the basis of
interpretation on which humanistic knowledge production 1s based... we seem

ready and eager to suspend critical judgment in a rush to visualization.

Johanna Drucker — Humanities Approaches to Graphical Display



o Warnings
» Data format limits use, already an act of
interpretation.
» Statistics is often misused (wield it very carefully).
» Interpreting spatial distance as meaningful.

» Always include a legend (this presentation breaks

that rule).

» Accidental legitimization in eyes of public.



Network Analysis & Visualization in the Humanities:
Examples In The Wild



Digital Humanities 2011 — Elijah Meeks
http://dh2011network.stanford.edu/
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Digital Humanities 2011 — Elijah Meeks
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Digital Humanities 2011 — Elijah Meeks
http://dh2011network.stanford.edu/
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Digital Humanities 2011 — Elijah Meeks
http:/ /dh2011network.stanford.edu/

G

General information

‘Nodes:621
Edges: /34

: Metrics
Average degree:2.36
+

o
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O Digital Humanities 2011 — Elijah Meeks

http:/ /dh2011network.stanford.edu/

DHAnswers: Building a Corumunity-Basgd Q&A Foard for the Digital Humanities

Historic Interpretation, Preservation, and® Augmented Eea]it}r in Falmouth Jama:

Possible Worlds: Authorial markup and digital scheolarship
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O Character Networks in the 19™ Century British Novel
-Graham Sack

I use computational methods to count the frequency and co-
occurrence of a generally ignored sub-class of common words,
namely, character names. Character names are often regarded as
noise and excluded from authorship and stylistics analysis
because they are not consistent across texts. This study makes
character names its main object of analysis because the
objective is quite different: rather than style or authorship, this
study attempts to make inferences about characterization and
social form, two areas about which computational analysis has

had comparatively little to say.




Figures 20a, b, & C

The Ambassadors (James)

General Features:

*Small network (12 characters)

*No isolates

*Very high graph density (71%) and clustering
coefficient (85%)

*Low average path length (1.3)

*Low degree inequality (-4.9)

*High proportion of strong ties (28%)

Conclusions

*Tightly knit social world focused on deep
relationships between small set of characters
*Sorial interaction hrnadlv evenlv distributed

Character Network Sociograms

Middlemarch (Eliot))
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General Features:

*Large network (SS characters)
*Moderately high % of isolates (17%)
*Low graph density (7%) and clustering
coefficient 73%)

*High average path length (2.4)
*Moderate degree ineguality (1.9)
*Moderate proportion of strong ties (18%)

Conclusions

*Large but comparatively integrated social
world with deep interaction between core
characters

The Pickwick Papers (Dickens)
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General Features:

*Large network (112 characters)

*High proportion of isolates (20%)

*Very low graph density (4%) and clustering
coefficient (72%)

*High average path length (2.2)

*High degree inequality (3.0)

*Low proportion of strong ties (13%)

Conclusions

*Expansive but diffuse social world with
passing social interactions and many isolated
characters



Social Metrics — By Novel (1/3)

' Eigure 21. Number of lsolates
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Figure 22. Percentage of “Socially Isolated” Characters

&
2
£ 4

<
G

TR rTSEGAY M|
VIR B
AN, = T WL
Ak A PUE | a0
R Ll |

e LN

a8 sy

ann] ay) e B L
amae

azpnling pue sy
TR | )

EUTLH TR =
b B EL TR T

E s ' |

duat pang

BT T
s ey
) PR R
L B ey
PuB B, 4267
[P S BTy

FLEERAIG ] Baae] O AL ]
U g L
AT L ] A
iy Rl

e AR

EILEE ]

imm) iam
Ry

L 0k ]

L B

FPARYLE AL
W] Hurl
lanag £ lapng ipe)
S PE L
SIFNT RN, LA
g gL e g
1ERS ) s
YRIPEH

Ay

LLETEY

AN A

VAR [SCRfIS 1mE i win)
AP

Sp v o pRney )
DINFE O W agar
1ANF QU BN

L L]

EE TR 20 .y
AR WPEY

veniig my)

Lo B L L]
RRELLNE s E N T
aleygp g
LT T
S AR S LT
Aucunow Ryl

LR TE R N TR R L L
LTSN AN A Ay,
Ll ]



Word Co-Occurrences in European Fairytales
-Jorgensen & Weingart

. Foot

[ Little Y Dear

@ Od @ Blood

‘ Broad
. Cloven

@ Young .
Flat o Head
‘ Naked

Hand
@ Han @ Human

@ Right $ Toe
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-Jorgensen & Weingart

Word Co-Occurrences in European Fairytales
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Abarcay Boka, coice e Araida, P
Abaezit, Fim e

Abe rcromby, 1sthamon Deremlhe,

Abe rcromby, Coloie | James

Abos o Bhawlle, Avblhie Maxim|.
Adam , Arohe

Adam , Wiliam
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Workshop Overview

1:00-1:15 Introduction to Network Analysis

1:15-1:45 Network Analysis & Visualization in the Humanities

*  Theory, Applications, and Pitfalls.

. Examples In The Wild

1:45-2:15 Collecting, Cleaning & Formatting Data

2:15-2:25 Break

2:25-3:00 Sci2 Tool Basics

. Macroscope Design and Usage.

. Download and run the tool.

. Find basic statistics and run various algorithms over the network.
. Visualize the networks as either a graph or a circular hierarchy.

3:00-3:20 Sci2 Workflow Design: Padgett's Florentine Families - Prepare, load,
analyze, and visualize family and business networks from 15th century
Florence.

3:20-3:35 Break

3:35-4:00 Sci2 Research Demonstration: Mapping the Republic of Letters

4:00-4:30 Q&A and Technical Assistance
33



Collecting, Cleaning & Formatting Data



o Data Collection

» 65% collecting, 25% cleaning, 5% formatting, 5%
analysis.

» Keep analysis in mind before first data collected

» Remember not just current use but future use as
well; nobody wants to do the same work five times.

» Make sure system for data entry is easy,
transferrable, and as granular as possible.



O Data Cleaning & Validation

» Multiple coders? Undergraduates? Check for
intercoder reliability. Understand biases going in.

» Microsoft Excel is your friend (ubiquitous, easy).
» Consistency in word use and coding.

» Sanity checks at the extremes — order by size, etc.
» Check against existing databases if available.

» Make sure basic statistics make sense.



File-types

» Excel

» Database

» Text

» CSV



N Newton | Oldenburg

° ~  Network Formats Newton 0 13
7
% 4 Oldenburg 24 0
Flamsteed 62 7
» Matrix
» Adjacency List N
» Node & Edge List ! Newton
2 Oldenburg
3 Flamsteed
Newton Oldenburg | 13
Edges
Newton Flamsteed @ 38
1 2 13
Oldenburg | Newton 24
1 3 38
Oldenburg = Flamsteed @ 45
2 1 24
Flamsteed | Newton 62
2 3 45
Flamsteed @ Oldenburg @ 7
3 1 62
3 2 7

Flamsteed
38
45
0



o NWB Format

*Nodes

id*int label*string totaldegree*int

16 “*Merwede van Clootwyck, Matthys van der (1613-1664)" 1
36 “Perrault, Charles” 1

48 “Bonius, Johannes” 1

67 “Surenhusius Gzn., Gulielmus” 1

99 “Anguissola, Giacomo” 1

126 “Johann Moritz, von Nassau-Siegen (1604-1679)" 6
131 “Steenberge, J.B.” 1

133 “Vosberghen Jr., Caspar van” 1

151 “Bogerman, Johannes (1576-1637)" 25
*DirectedEdges

source*int target*int weight*float eyear*int syear*int
16 36 1 1640 1650

16 126 5 1641 1649

36 48 2 1630 1633

48 16 4 1637 1644

48 67 10 1645 1648

48 36 2 1632 1638

67 133 7 1644 1648

67 131 3 1642 1643

99 67 9 1640 1645

126 16 3 1641 1646

131 133 5 1630 1638

131991 1637 1639

133 36 4 1645 1648

13348 8 1632 1636

151 48 6 1644 1647

. Johann Maritz, von Massau-Siegen (1604-1673)

. Merwede van Clootwyck, Matthys van der (1613-1664)

. Bonius, Johannes
. Perrault, Charles

. Vosberghen Jr., Caspar van

& Bogerman, Johar

. Surenhusius Gzn., Gulielm

. Steenberge, J.B.

. Anguissola,
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Workshop Overview

1:00-1:15 Introduction to Network Analysis

1:15-1:45 Network Analysis & Visualization in the Humanities

. Theory, Applications, and Pitfalls.

e  Examples In The Wild

1:45-2:15 Collecting, Cleaning & Formatting Data

2:15-2:25 Break

2:25-3:00 Sci2 Tool Basics

. Macroscope Design and Usage.

. Download and run the tool.

*  Find basic statistics and run various algorithms over the network.
*  Visualize the networks as either a graph or a circular hierarchy.

3:00-3:20 Sci2 Workflow Design: Padgett's Florentine Families - Prepare, load,
analyze, and visualize family and business networks from 15th century
Florence.

3:20-3:35 Break

3:35-4:00 Sci2 Research Demonstration: Mapping the Republic of Letters

4:00-4:30 Q&A and Technical Assistance
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Sci2 Tool Basics:
Macroscope Design and Usage



Microscopes, Telescopes, and Macrocopes

Just as the microscope empowered our naked eyes to see cells, microbes, and viruses
thereby advancing the progress of biology and medicine or the telescope opened our
minds to the immensity of the cosmos and has prepared mankind for the conquest of
space, macroscopes promise to help us cope with another infinite: the infinitely complex.
Macroscopes give us a ‘vision of the whole’ and help us ‘synthesize’. They let us detect
patterns, trends, outliers, and access details in the landscape of science. Instead of making
things larger or smaller, macroscopes let us observe what is at once too great, too slow, or
too complex for our eyes.



Desirable Features of Macroscopes

N
AN
s LTI

Core Architecture & Plugins/Division of Labor: Computer scientists need to design
the standardized, modular, easy to maintain and extend “core architecture”. Dataset

and algorithm plugins, i.e., the “filling”, are provided by those that care and know
most about the data and developed the algorithms: the domain experts.

FEase of Use: As most plugin contributions and usage will come from non-computer
scientists it must be possible to contribute, share, and use new plugins without writin

one line of code. Users need guidance for constructing effective workflows from 100+

continuously changing plugins.
Modularity: The design of software modules with well defined functionality that can be

Y.
flexibly combined helps reduce costs, makes it possible to have many contribute, and
increases flexibility in tool development, augmentation, and customization.

Standardization: Adoption of (industry) standards speeds up development as existing
code can be leveraged. It helps pool resources, supports interoperability, but also eases

the migration from research code to production code and hence the transfer of

research results into industry applications and products.
Open Data and Open Code: 1ets anybody check, improve, or repurpose code and eases

the replication of scientific studies.
Macroscopes are similar to Flickr and YouTube and but instead of sharing images
or videos, you freely share datasets and algorithms with scholars around the globe.

Bérner, Katy (in press) Plug-and-Play Macroscopes. Communications of the ACM.



Macroscope Design

Custom Tools for Different Scientific Communities
Information Visualization Cyberinfrastructure
http://iv.slis.indiana.edu
Network Workbench Tool + Community Wiki
http://nwb.slis.indiana.edu

Science of Science (Sci?) Tool and Portal
http://sci.slis.indiana.edu

Epidemics Cyberinfrastructure

http://epic.slis.indiana.edu/

180+ Algorithm Plugins and Branded GUIs
+

Core Architecture

Open Services Gateway Initiative (OSGi) Framework.
http://orgi.org
Cyberinfrastructure Shell (CIShell)
http://cishell.org

=
= B
et se?ClShell

45
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CIShell Powered Tools:
Network Workbench (NWB)



Network Workbench Tool

A Workbench for Network Scientists ° ° * 1
http.//nwb.shs.mdlana. NWB Downloads Cummulative
70,000 - Oct. 2006-Feb. 2010
50,000
The Network Workbench (NWB) tool 50,000 f
supports researchers, educators, and "
. . . . =
practitioners interested in the study of s 40,000
. . . . . = (LOGIN )
biomedical, social and behavioral science, 3
. & 30,000 Dev Zone About
physics, and other networks. = j’
1 Summary
In February 2009, the tool provides more 169 e Y orency | 20000 _
plugins that support the preprocessing, T f = |
. . . . . | twark [ — _.;
analysis, modeling, and visualization of (0WE) The envisond 10000 o P
mare
networks. How to cite this proje —
|:| .
More than 50 of these plugins can be News & Updates S T R S
. . . + 5.1.09 Kaglble, 5 S 2 2 25 35 8 2 2 &
applied or were specifically designed for Knowletite A6 F 0888 g8 88
. {wehsite accesse ]
S&T studies. Time
+ 3.23.09 1.0.0 heta & Released [ TWindows (P & vista)| <]
= 1.23.09 Ann Meranie's utarial abstract for Sunhelt
2004
It has been downloaded more than 65,000 + 11.4.08 Two NWB Pis featured in “Connected—The  etting Started
. . Power of Six Degrees.” 2008. Anna Maria Talas, See more documentation
Director. Australian Broadcasting C ation, Ltd. -
times since December 20006. T ke

Birner, Katy, Huang, Weixia (Bonnie), Linnemeier, Micah, Dubon, Russell Jackson, Phillips, Patrick, Ma, Nianli, Zoss, Angela, Guo,
Hanning & Price, Mark. (2010). Rete-Netzmwerk-Red: Analyzing and Visunalizing Scholarly Networks Using the Network Workbench Tool.
Scientometrics. V'ol. 83(3), §63-876.
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Investigators:

Software Team:

Goal:

Amount:
Duration:

Website:

Katy Borner, Albert-Laszlo Barabasi, Santiago Schnell,
Alessandro Vespignani & Stanley Wasserman, Eric Wernert

Lead: Micah Linnemeier

Members: Patrick Phillips, Russell Duhon, Tim Kelley & Ann McCranie

Previous Developers: Weixia (Bonnie) Huang, Bruce Herr, Heng Zhang,
Duygu Balcan, Bryan Hook, Ben Markines, Santo Fortunato, Felix
Terkhom Ramya Sabbmem Vivek S. Thakre & Cesar Hidalg

Develop a large-scale network analysis, modeling and visualization toolkit
for physics, biomedical, and social science research.

$1,120,926, NSF 11S-0513650 award
Sept. 2005 - Aug. 2009

http://nwb.slis.indiana.edu
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Project Details (cont.)

NWB Advisory Board:

James Hendler (Semantic Web) http://www.cs.umd.edu/~hendler/

Jason Leigh (CI) http://www.evl.uic.edu/spiff/

Neo Martinez (Biology) http://online.sfsu.edu/~webhead/

Michael Macy, Cornell University (Sociology) http://www.soc.cornell.edu/faculty/macy.shtml
Ulrik Brandes (Graph Theoty) http://www.inf.uni-konstanz.de/~brandes/

Mark Gerstein, Yale University (Bioinformatics) http://bioinfo.mbb.vale.edu/

Stephen North (AT&T) http://public.research.att.com/viewPage.cfm?PagelD=81

Tom Snijders, University of Groningen http://stat.gamma.rug.nl/snijders/

Noshir Contractor, Northwestern University http://www.spcomm.uiuc.edu/nosh/
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Computational Proteomics

What relationships exist between protein targets of all drugs and all
disease-gene products in the human protein—protein interaction network?

Yildriin, Mubammed
A., Kwan-1I Gobh,
Michael E. Cusick,
Albert-1 dszlo Barabast,

and Marc Vidal. (2007).

Drug-target Network.
Nature Biotechnology
25 no. 10: 1119-112¢.

@ @ 2007 Nature Publishing Group
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Figure 2 Drug—target network (DT network). The DT network is generated by using the known associations between FDA-approved drugs and their target
proteins. Circles and rectangles correspond to drugs and target proteins, respectively. A link is placed between a drug node and a target node if the protein

is a known target of that drug. The area of the drug (protein) node is proportional to the number of targets that the drug has (the number of drugs targeting
the protein). Color codes are given in the legend. Drug nodes (circles) are colored according to their Anatomical Therapeutic Chemical Classification, and the
target proteins (rectangular boxes) are colored according to their cellular component obtained from the Gene Ontology database.
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Computational Economics
Does the type of product that a fishing
country exports matter for

subsequent economic performance? 8
vegetables 74
coffee and cocoa 3 :
products ;

C. A. Hidalgo, B. Kiinger, <z
A.-L.. Barabas:, R. Hausmann

(2007) The Product Space
Conditions the Development
of Nations. Science 317,
482 (2007).
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period. (B) Network representation of the product space. Links are color coded  Leamer.
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Computational Social Science

Studying large scale social

Image: Bruce W. Hedr and Todd M. Holloway

Power struggle
networks such as Wikipedia How do you keep track of the bubbling

mass of information that is Wikipedia?
This chaotic-leoking mosaic is one
attempt to show which topics are
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Computational Epidemics

Forecasting (and preventing the effects of) the next pandemic.

Epidemic Modeling in Complex realities, V. Colizza, A. Barrat, M. Barthelemy, A.1V espignani, Comptes Rendus

Biologie, 330, 364-374 (2007).

Reaction-diffusion processes and metapopulation models in heterogeneous networks, 1.Colizza, R. Pastor-Satorras,
A.Vespignani, Nature Physics 3, 276-282 (2007).

Modeling the Worldwide Spread

of Pandemic Influenza: Baseline

Case and Containment Interventions,

V. Colizza, A. Barrat, M. Barthelem,
A.-J. Valleron, A.1V espignan,
PloS-Medicine 4, e13, 95-110 (2007).
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A Warkbench for Network Scientists

NWB Tool 1.0.0

Can be freely downloaded for all
major operating systems from
http://nwb.slis.indiana.edu

Select your operating system from
the pull down menu and download.

Unpack into a /nwb directory.

Run /nwb/nwb.exe

Session log files are stored in
“Syournwbdirectory*/ logs’ directory.

Cite as

NWB Team. (2006). Network
Workbench Tool. Indiana University,
Northeastern University, and University of
Michigan, hitp:/ [ nwb.slis.indiana.edn.
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A Warkbench for Network Scientists

% Network Workbench Tool

File Preprocessing Modeling  Analvsis  Wisualization Scientometrics  Help

El cansale

(save, load, view, etc.] and

ain} Data Manager =8

[ ]

Console displays data operations — B
~

Wielcome to the Netw:

reprocessing, modeling, analysis, and
|visualization of small,

algorithm input parometers,
selection, & acknowledgements as
The Metwork Warkbend well as error reporting. s supported in park by the MSF

115-0513650 award, ThEprmerrrresogearorsare o ey oo, Ot Albert-Laszld Barabasi, Dr, Santiago
achnell, Dr, Alessandro Yespignani, D, Stanley \Wasserman, and Dr, Eric &, Wernerk,

The MWWE kool was developed by Weixia Huang, Russell Duhon, Micah Linnemeier, Timakhy Kelley, Duygu
Balcan, Mariano Beird, Bruce Herr, Santo Fortunato, Ben Markines, Felix Terkhorn, Heng Zhang, Megha
Ramawat, César Hidalgo, Ramya Sabbineni, Wivek Thakres, Soma Sanwal, Ann McCranie, Alessandro
Wespignani, and Katy Birner, It uses the Cwberinfrastructure shell (http:/ fcishell.org) developed at the
Cvberinfrastructure for Mebwark, Science Center (http:/ fons.slis.indiana.edu) at Indiana University,

Please cite as Follows;

[MWE Team, (20060, Mebwork Workbench Tool, Indiana University and Mortheastern University,
ihtl:p:,-",-’nwh.slis.indiana.edu

v
Scheduler lists what algorithms you've = 5
& scheduler used and displays algorithm
. progress.
Remawe Fram List |
| || Algorithm Mame Dake Tirne % Complete

Data Manager keeps track of
all datasets that are available
for algorithmic visualization
or manipulation.

Table
E Matrix-
2% Plot

=]
= Text
G Gusss

9 Tree

i *« Network-

Console shows references to seminal works.

Workflows are recorded into a log file, and soon can be re-run for easy replication.

All algorithms are documented online; workflows are given in tutorials.
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A Workbench for Network Scientists

File, Preprocessing, Modeling, and Visualization Menus

[File |

Preprocessing

Madeling

Load. ..

Load and Clean ISI File
Read Directory Hierarchy
Dakasets

Exctrack Top Modes

Extract Modes Abowve or Below Yalue
Remove Mode Attributes

Delete High Degres Modes

Save...

Delete Random Modes
Delete Isolates

View, .,
Wigw with. ..

YWisualization

Randaom Graph
Wi'atks-Strogatz Small Wiorld
Barabasi-albert Scale-Free

GLUESS

ERURok

Can
hord

Extract Top Edges
Extrack Edges Above or Below Yalue

Merge Mode and Edge Files
Split Graph to Mode and Edge Files

Remove Edge Attributes
Remove Self Loops

Tesks

Trim by Degree

Hyperagrid
PRLU

DL (xOrd)
Specified {prefuse beta)

Circular {JUMG)

Radial Tree/Graph (prefuse alpha)

TARL

Radial Tree/Graph with Annotation {prefuse beta)

Miscrete Metwark Dynanmics (DHED

Tree Map (prefiuse beta)

Evolving Metwork (Mieighted)

Preferences

snowball Sampling (n nodes)
Mode Sampling

Exit

Edge Sampling

Tree Yiew (prefuse beta)
Balloom Graph (prefuse alpha)

Borner, Katy, Sanyal, Soma and Vespignani, Alessandro (2007). Network Science. In Blaise Cronin (Ed.),
ARIST, Information Today, Inc./ American Society for Information Science and Technology, Medford, NJ,

Swrnmekrize
Dichotomize
Mulkipartite Joining
Mot alize Text
Slice Table by Time

Volume 41, Chapter 12, pp. 537-607.
http://ivlslis.indiana.edu/km/pub/2007-borner-arist.pdf

Force Directed with Annotation (prefuse beta)
Kamada-kawai (UG

Fruchterman-Reingold (MG}

Fruchterman-Feingold with &nnotation {prefuse beta)
Spring (IUMG)

Small World {prefuse alpha)

Parallel Coordinates (demo)

Lalet

Circular Hierarchey
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Analysis Menu and Submenus

A Workbench for Network Scientists

analysis Unweighted and Undirected b | Unweighted and Directed » |

Metwork Analysis Toolkit (NAT) e De'?!'e'? ‘ :D:E lcl;'d;gree
Unweighted and Undirected Peziceiiaiion : ° p =P ;TT .

. . ndegree Distribution
weighted and Undirected Watts-Strogatz Clustering Coefficient o

. : Outdegree Distribution
Unweighted and Directed Watts Strogatz Clustering Coefficient over K
Weighted and Directed k-Mearest Meighbor
Diameter . .
Single Node In-Out Deqgree Correlations

Search Average Shorkest Path
Discrete MNetwork Dynamics Shortest Path Distribution PageRank
Textual Mode Betweenness Centrality HITS

Global Connected Components
P Dvad Reciprocity

\Weighted and Undirected b I HITS Arc Reciprocity

, - Adjacency Transitivity
Clustering Coefficient Weak Component Clustering
Mearest Meighbor Degree Blondel Community Detection Weak Component Clustering
Strength vs Degree Strong Component Clustering

Degree & Strength MST-Pathfinder Metwork Scaling

Average Weight vs End-point Deagree
kK-Mearest Neighbor (1ava)

Blondel Community Detection
Extrack K-Core

Annaotate K-Coreness Extract K-Core
Strength Distribution Annotate K-Coreness
\Weight Distribution Weighted and Directed 3 I_
Randomize Weights HITS Search P TR y
MST-Pathfinder Network Scaling Weighked PageRank an ELrE E'Ete':ti':"—'\_‘
Fast Pathfinder Metwork Scaling Fast Pathfinder Metwork Scaling Chord

K Random-Wall Discreke Metwork Dynamics »

Blondel Community Detection Elondel Community Detection Random Breadth First Extract and &nnotate Atbractors

Borner, Katy, Sanyal, Soma and Vespignani, Alessandro (2007). Network Science. In Blaise Cronin (Ed.),
ARIST, Information Today, Inc./ American Society for Information Science and Technology, Medford, NJ,
Volume 41, Chapter 12, pp. 537-607. http://ivLslis.indiana.edu/km/pub/2007-bornet-arist.pdf
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A Workbench for Network Scientists
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Interpreter . Graph Mndlﬁar/

Gnuplot

portable command-line driven
interactive data and function plotting
utility http://www.gnuplot.info/.

GUESS

exploratory data analysis and visualization tool
for graphs and networks.

https://nwb.slis.indiana.edu/community/?n=Vi

sualizeData. GUESS.
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Supported Data Formats

The NWB tool supports loading the following input file formats:
GraphML (*.xml or *.graphml)

XGMML (*.xml)

Pajek .NET (*.net) & Pajek .Matrix (*.mat)

[
NWB (* nWb) 2 . file text/nsf
’ edu.berkeley.guirprefuse.graph.Graph
TreeML <*-Xm1> . edu.berkeley.guir.prefu:e.graph.TrJ

Edge hSt (*-edge) . eduuciicsjunggraphGraph

®
CSV <*.CSV) . se.d ata.Treef /
filertext/bibtex

file:textAgmml+xml . filestext/isi

. file text/scopus
refuse.data.Table

.. @ _
ISI (*.181> e textftree ml+xml . prefuse.data.Graph
Scopus (*.scopus)
NSF (*.nSf) . file:text//csv
. . . file:text/graphml +xml
Bibtex (*.bib)

. file:text/referbib

VVVVVVYVYVYVYVYVYVYVYY

Endnote (*.CHW) @ filestext/ps
and the following network file output formats: .W“’ﬂ /
GraphML (*.xml or *.graphml) / ® ccoean ® . cocimage suteredimage
Pajek MAT (*.mat) L file:application/pajeknet \
Pajek .NET (*.net)
NWB (*nWb) o file:application/pajekmat
XGMML (*.xml)
CSV (*.csv)

Formats are documented at https://nwb.slis.indiana.edu/community/?n=DataFormats.HomePage.

. filetext/jpg

YVVVVVY
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CIShell Powered Tools:

Science of Science (Sci2) Tool



Science of Science (Sci2) Tool
http://sci.slis.indiana.edu

» Explicitly designed for SoS research and practice, well documented, easy to use.

» Empowers many to run common studies while making it easy for expotts to
perform novel research.

A\

Advanced algorithms, effective visualizations, and many (standard) workflows.

A\

Supports micro-level documentation and replication of studies.

A\

Is open source—anybody can review and extend the code, or use it for

commercial purposes.
SUMMARY

e Existing metrics have known flaws
e Areliable, open, joined-up data
infrastructure is needed
e Data should be collected on the full
O P | N | O N range of scientists’ work
e Social scientists and economists

should be involved

nature Vol 46425 March 2010

Let’'s make science metrics more scientific

To capture the essence of good science, stakeholders must combine forces to create an open, sound and
consistent system for measuring all the activities that make up academic productivity, says Julia Lane.


http://sci.slis.indiana.edu/

! O(‘) for f : .
A i Sci2Tool - “Open Code for S&T Assessment”

Joint Co-Authorship Network

OSGi/CIShell powered tool with NWB plugins and

many new scientometrics and visualizations plugins.
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DLI-2: Creating the Digital Music Library
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Baorner, Katy, Huang, Weixia (Bonnie), Linnemeier, Micah, Dubon, Russell Jackson, Phillips, Patrick, Ma, Nianli, Zoss,
Angela, Guno, Hanning & Price, Mark. (2009). Rete-Netzwerk-Red: Analyzing and Visnalizing Scholarly Networks
Using the Scholarly Database and the Network Workbench Tool. Proceedings of ISST 2009: 12th International Conference
on Scientometrics and Informetrics, Rio de Janeiro, Brazil, July 14-17 . V'ol. 2, pp. 619-630.



Sci? Tool

v Sei’ Tool

File Preprocessing Modeling  &nalysis | Wisualization | Scientornetrics  Help

El Caonsole

Welcome to the Science of Science Tool (5o
The development of this tool is supported in
Metwork Science center and the School of Li
Indiana University, the Mational Science Fou
and I5-0715303, and the James & tcDonnel
Cyherinfrastructure portal thttpefiscislis.ind

The primary investigators are Katy Barner, In
SciTech Strategies Inc, The Sci tool was dev
1, Duhon, Patrick &, Phillips, Chintan Tank, a
Cyberinfrastructure Shell thttp:ffcishell.org
for Metwork Science Center thitpeffons.slis.ii
Mary algorithrm plugins were derived from t
ihttp:/inwb.slis.indiana.edu).

Please cite as follows;
Sci® Tearn, (2009), Science of Science Tool, Ir
Strategies Inc,, http:ffsci.slis.indiana.edu,

El scheduler

[F{emwe Frarm List] [ Remowve completed

GLESS
GruPlot

Radial Tree/Graph (prefuse alpha)

Radial Tree/Graph with Annotation (prefuse beta)
Tree Wiew {prefuse heta)

Tree Map (prefuse beta)

Force Directed with Annotation (prefuse beta)

Fruchterman-Reingold with Annotation (prefuse beta)

Dirl MfCrd)
Specified (prefuse beta)

Haorizantal Line Graph

Circular Hierarchy

Geo bap (circle annotations)

Geo Map (region coloring annotations)
Irmage Wiewer

Reftdapper

I Algorithrm Marne Date

[ Load and Clean ISIFile

] Extract Co-futhor Meta.,, 09703742009
09/03,2009

Tirme % Coarr
00:15:20 Ahkd

i | 1]

L
00:15:05 Akd -
|

Circular Hierarchy

r||




A tool for”
S &

nce ofgcience
YeSéarch & practice
X LI A\

Sci? Tool: Download, Install, and Run

Sci? Tool 0.5 Alpha (May 2011)

Can be freely downloaded for all major
operating systems from
http://sci.slis.indiana.edu/sci2

Select your operating system from the
pull down menu and download.
Unpack into a /sci2 directory.

Run /sci2/sci2.exe

Session log files are stored in
“Syournwbdirectory*/ logs’ directory.

Cite as

Sci Team. (2009). Science of Science (Sci) Tool.

Indiana University and Sci'lech Strategies,
bttp:/ [ sci.slis.indjana.edn

/= Sci? Registration : Welcome - Windows Internet Explorer

%ﬂ - |E| hitkpsffsci slis indiana.edu/registrationjuser

SAENRE RS ’?‘nih building 31 campus map ||P '|

File Edit “iew Favorites Tools Help

57 Favarites | 95 & suggested Stes @] Free Hotmail €] Web Slice Gallery ~

| (€ 5ci? Registratio

A tool for science of science research & practice
Email Address

Password

Forgot your password?

To rzcover your account password, please visit our password recovery page

Not registered vet?

Register now

Tuterials

Scott Weingart, Hanning Gue, Katy Borner, Kevin W. Boyack, Micah W. Linnemeier, Russell . Duhon, Patrick A Phillips, Chintan Tank, and Joseph
Biberstine (2010) Science of Science (Sci2) Tool User Manual. Cyt fi ure for Network Science Center, School of Library and Information
Science, Indiana University, Bloomington.

Katy Borner and Angela Zoss (2010) Plug-and-Plav Macroscopes Tutorial. International Conference on Secial Computing, Behavioral Modeling and
Pradiction, Bethesda, MD-.

In the news

The Trustees of Indiana University. SLIS researcher promotes Innovation Dashboard for policvmakers during Capitel Hill visit. (website accessed
12/22/09).

Please cite as

Sei’ Team (2009). Seience of Science (Sci') Tool Indiana University and SeiTech Strategies, hitp-/sci slis indiana edu

Acknowledgements

This work is supported in part by the Cyberinfrastructure for Network Science Center and the School of Library and Information Science at Indiana
University, the National Science Foundation under Grant No. SBE-0738111 and IIS-0513630, and the James S. McDonnell Foundation.

[[J INDIANA UNIVERSITY 0 B .
[ SCHOOL OF LIBRARY AND James 5. McI
INFORMATION SCIENCE e

64


http://sci.slis.indiana.edu/sci2
http://sci.slis.indiana.edu/

e
DR LGRS =
&lce ofgcience

~ @ivewl Sci? Tool: Download, Install, and Run

\ B

Sci? Tool 0.5 Alpha (May 2011)

Has new features such as

» New Geographic Visualizations

» STAR database (download separately)

» Colored Hotizontal Bar Graphs
» Supports ASCII UTF-8 characters

» Bug fixes, streamlined workflows

Unzip and run /sci2/sci2.exe

Cite as

Marne Size
0-3(1)
T 2010-03-sci2-rmanual pdf 10,947 KB
Q-Z4)
1) 5ci2-M-1.0.0,201008130505M G T-rmacosx.carbon.ppezip 01,415 KB
Y sci2-M-1.0.0.201008130505MGT-rmacosx carbonxBh.zip 91,414 KB
i sci2-M-1.0.0,201008130505MGT-rmacosx cocoax86_6d.zip 89,717 KB
1) 5ci2-M-1.0.0.201008130505MN G T-win32 win32.x86 zip 91,374 KB
1, sci2-N-1. R _ 91,374 KE
i Erowvse with Corel Paint Shop Pro Photo X2

Open Cormrmand Prompt Here

Extract &ll...

Scan for Wiruses.,.,

-Zip ] Open archive
Opern With,., Extract files...
3 MagicISO R Extract Here

Sc# Team. (2009). Science of Science (Sci) Tool. Indiana University and Scilech Strategies,

http:/ [ sci.slis.indiana.edu
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Sci2 Tool Interface Components

USC v Sei? Toal F=SlEcE =

File Data Preparation Preprocessing  &nalysis  Modeling  Visualization  Help

El Console = B | i Data Manager =0
» Menu to read data, run i . vaavamager]_ = O

‘Welcome to the Science of Science Tool (Sci). "g Directory Tree - Prefi

. The developrent of this tool is supported in part by the Cyberinfrastructure for N
algorlthms. Metwork Science center and the School of Library and Information Science atIndiana |2
University, the National Science Foundation under Grant Mo, SBE-0738111 and | &
[O5-0715203, and the James 5, BMcDonnell Foundation. See Science of Science
> Cyberinfrastructure portal thttp:ffscislis.indiana.edu) for more information,
Console to see work log,
. Pritmary investigators are Katy Birer, Indiana University and Kevin W, Boyack, SciTech
Strategies Inc. The Sci® tool was dewveloped by Micah W, Linnerneier, Russell 1. Dukan,
. 9 ped by
Patrick &, Phillips, Chintan Tank and Joseph E|berstme It uses the Cyberlnfrastructure A
R e L A e | R EXR T PN Ry PR i Sy peryee ey o Fmw Blmdnim el T -
» Data Manager to select, view, || s =g

save loaded, Simlﬂated, or [[|Rernove completed automatically | Remowe all completed

derived datasets.

! Algorithm Mame Date Tirne % Cormpl
> SCheduler to see Status Of | Read Directary Hierarchy  08/15/2010 170217 PN
. . < | 10 | b S
algorithm execution. S ;

All workflows are recorded into a log file (see /sci2/logs/...), and soon can be re-
run for easy replication. If errors occur, they are saved in a error log to ease bug
reporting,

All algorithms are documented online; workflows are given in tutorials, see
http://sci.slis.indiana.edu/sci2 and http://nwb.slis.indiana.edu > Community
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Sci2 Tool — Read+Visualize Sci2 Tool Directory Tree

Use File > Read Directory Hierarchy’ with parameters

Il R.ead Directory Hierarchy x|
Fook direckory | CDaocuments and SettingsikatyDeskiop)mab ‘“-?r"
Lewvels ko recurse I 1 .y
W Recurse the entire tree ‘“-?r"
[~ Read directories only (skips Files) Jg

] Cancel |

Visualize resulting ‘Directory Tree - Prefuse (Beta) Graph’ using
*  Visualization > Tree VView (prefuse beta)’

*  Visualization > Tree Map (prefuse beta)’

*  Visualization > Balloon Graph (prefuse alpha)’

*  Visualization > Radjal Tree/ Graph (prefuse alpha)’
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B 1ree View (prefuse beta) P =[]
- WormMint.nwb
YeastMINT vab
DD

convertGraph_v0.8.0.graphml
Forentine.nwl
Fiendster.graphml xml
friendster xgmmxmi
humanprat.nwb
kidscontest.net

network netscibb-conferance.net
PSYCHCONSULT nwb
ssivuraraphmlml
terror.graphml.xml
terror xgmeml.eml
wikipedia-20080103-science.enmwh oo
bibtex bibsonomy bib
EpiC_200805 14, BibTex bib
csv barabasi.csv
endnote barabasi enw
bestlehorn.isi
FourletSciResearchers is
savedrecs-barabasi.isi
- savedrecs-garfieldsi
S savedrecs-vespignani isi
savedrecs-wasserman.isi
testSpapers.is
ThreeletSciResearchers isi
models TARL
Cornell nsf
Indiana.nsf
scientometrics
nsf Michigan.nsF
SciSIP-07-08.nsF
bibtexCoAuthorship.properties
endnoteCoAuthorship properties
isiCoAutharship.properties
isiCoCitation properties
isiPaperCitation properties
mer geBibtexAuthors pr operties
properties mer geEndnoteAuthors properties
mer gelsiAuthors.propartiss
mer gel sfP1s properties
mer geScopusAuthers.propatiss
nsfCoP1properlies
nefPIToProject propartiss
scapusCoALthorship pr operties
scopus BrainCancer scopus
Aorentine.mwb
Friandster graphml.xmi
socialscience Friendster xgrmml.xm|
s subee tarror.graphmlaml

terror xgmml.xml

Tree Map {prefuse beta)

BalloonTree

Different views of the
/nwb directory
hierarchy.

oY o
L r
s )

Enstallatiu:uninfu:urmatiu:un ]l

eclipzeproduct
n.d. release

Note the size of the o
. . "y i
/plugin directory. © - nstaler

=10l x|

.
| £| Radial Tree/Graph (prefuse alpha]‘ — E@I&J

(edu.iu.nwb.gui.bland_1.D_D NMETA-INF

T aeT y

(bundles)

.manager

META-INF
META-INF

I 0.0

FreeHEF “eetorGraphies 1.0.0]
org.prefuse.Iib_2CICIEiCIT15.CI.CI)

/ [0. v20070522]

arg.ed org.a[lucene_2.3.2j|ib - 2.1]0ns
org.eclipse.equi _app |

org.eclipse.osgi
org.eclipse. update

N

OsG1-INF

0rg.cisheII.templates.jy‘thonrunner]

[META-INF)

Notlzed
Nur'B Files
-—.I-NotUsed Pajek NET rim;)\
Notlsed A5 hAL Files

edu.uciics.jung_1.7.4 METe: INF

[org.cishell.envilonment.equinox.featule]

[featu[es\ldu.iu.nuuh.ja\raalgorithm.feature]

[edu.iu.nuub.con\rerter.feature_'l .D.D)
\[otg.cishell.feature_'I .CI.CI)

[org.cishelI.reference.gui.feature)

eduiu.rwb.gui.brand.feature_1 .D.D]

[org.cishell.reference.feature_1 .D.D:I




Studying Four Major NetSci Researchers (ISI Data)

Time frame: 1955-2007

Region(s): Miscellaneous

Topical Area(s): Network Science

Analysis Type(s): Paper Citation Network, Co-Author Network, Bibliographic

Coupling Network, Document Co-Citation Network, Word Co-
Occurrence Network

Thomson Reuter’s Web of Knowledge (WoS) is a leading citation database cataloging
over 10,000 journals and over 120,000 conferences. Access it via the “Web of
Science” tab at http://www.isiknowledge.com (note: access to this database requires
a paid subscription). Along with Scopus, WoS provides some of the most
comprehensive datasets for scientometric analysis.

To find all publications by an author, search for the last name and the first initial
followed by an asterisk in the author field.
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Data Acquisition from Web of Science

@0 151 Web of Knowledge [¥3.0] - Netscape |3 1[
. Ele Edit “iew Go Bookmarks Tools Swindow Help

Download EI.H papers by i @O Q @ @ [ hetpsfiportal isknowiedge comiportsl.caitDest App—WOSBFunc—Frame | ‘:g = @

-j"’ B, 4% Home [ Netscape Q Searth| %% Customize... 5 f~spraof7g=t...

> E G f ld al @ Netscape = |Entsr Search Terms |'] 4 Search ¥ Highlight )Furm Fil = - Clear Broveser History ENEWS CAEmail »
ugeﬂe arric 2] Hew Tab [ % 151 web of Knowledas [v3.0] | %]
ISI Web of Knowledge™ Wb of Scionce 0| e o
» Stanley Wasserman Web of Science® =
[Rxwecome] | 2 mev | [0 creaner] | op conecn | [ povancen]
» Alessandro Vespignani General Search
select database(s) and timespan:
’ ’ s
> A lbej_’t— I aSZIO Barab381 Citation Databases:  Latest [1 week _»| (updated December 09, 2007)
[¥ i) Science Citation Index Expanded {SCI-EXPAMDED)--1955-present ¢ vear [z007 =]
¥ i) Social Sciences Citation Index (SSCI)--1956-present @ From [1355 1] to [z007 =] (default is all years)
fro [¥ i) Arts & Humanities Citation Index (48HCI)--1975-present T CemEGEr UiEse sogs, ek S i o reles,
Enter terms or phrases separated by the operators AND, OR, NOT, or SAME, and then press SEARCH. View our General Search tutorial
The search will be added to the search history. [== View your search history/combine sets]
» Science Citation Index =0 &
TOPIG: i) Enter one or more terms. Searches within article titles, keywords, and abstracts, =
Exarmple: oil spill* anD "North Sea" (How to search for phrases)
E ded (SCI-EXPANDED) | . e
Xpa’n e ( ) /| AUTHOR: i) Enter one or more author names (see author indes B3,
Exarnple: O'BRIAN C* OR OBRIAN C*
_._.l 9 5 5_present Author Finder: Meed help finding papers by an author? Use Author Finder.
GROUP AUTHOR: j) Enter one or more group names (see group author index 5]).
1 d Exarnple: CERN
SOURCE TITLE: i) Enter full journal titles (see full source titles list =0,
(SSCI) 1 956 Exarnple! Cancer* OR Journal of Cancer Research and Clinical Oncology
p PUBLICATION YEAR: i) Enter a publication year or range.
Exarnpde: 2001 or 1997-1999
» Arts & Humanities Citation
ADDRESS: i) Enter abbreviated terms from an author's affiliation {use abbreviations help).
I d ( ! E HCI) 1 975 Exarmple: Yale Univ SAME hosp
p Restrict search by languages and document types:
English 1 [Article . ]
Afrikaans Abstract of Published Itern =]
DR2ASBD] Sk Al
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Eugene Garfield

Stanley Wasserman

Alessandro Vespignani

Albert-1.asz16 Barabasi

Comparison of Counts
No books and other non-WoS publications are covered.

82

42

40
41

Total # Cites Total # Papers H-Index

1,525 672 31
122 35 17
451 101 33
2,218 126 47 (Dec 2007)

16,920 159 52 (Dec 2008)

72



1 for

scié;lce ofgcience

] ; A

research & practice
"

Extract Co-Author Network

Load*yoursci2directory™/ sampledata/ scientometrics/ isi/ FourlNetS ciResearchers.isi’

using 'File > Load‘ and parameters

I5] scholarly format
I:] database

# | Load
— The file you hawve selected can be loaded using ane ar
rnaore of the following formats,

Please select the format you would like to try,

| Select || Can

And file with 361 records

appears in Data Manager.

Rernowed 0 duplicate records,
Authar narmes hawve been narmalized.

361 records with unique ISTIDs are available via Data Manager,

Mirote log to

Chllsers\UsertAppDatatlocal\Ternphisiduplicaterermoverlog2534733993422022

Bl E
L

=] Scheduler] i

Rernowe From List | [C| Rernave completed automatically | Rernove all complete

! Algorithm Marne Date Time ¥

| Load and Clean ISI File 08/15/2010 0T:20:43PM

| Load and Clean ISI File 08/15,2010 07:12:49 P4
4| m |

% Sci2 Tool e =]
File Data Preparation Preprocessing  Analysis  Modeling  Visualization  Help
El Console] = O || ¥ Data Manager] =
Loaded 361 recards, E 18] Diata: ChUsers\UsertDesktopy10-MEH-A8H-Warkshap

361 Unique ISI Records

L1 2
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Extract Co-Author Network
(see section 5.1.4.2 on corvecting duplicate/ misspelled anthor names)

To extract the co-author network, select the 367 Unigue IS1 Records’ table and run
‘Data Preparation > Extract Co-Author Network’ using isi file format:

Il Extract Co-Author Net x|

Extracts a co-authorship network from one of several supported File
tvpes.

File: Formak Iisi j 9

] Cancel |

The result is an undirected but weighted network of co-authors in the Data Manager.

Run ‘Analysis > Network > Network Analysis Toolkit (INAT)’ to calculate basic
properties: the network has 247 nodes and 891 edges.

Use ‘Analysis > Network > Unweighted and Undirected > Node Degree’ to calculate the number
of neighbors for each node.

To view the complete network, select the ‘Extracted Co-Authorship Network’ and run
Visualization > Networks > GUESS”.

Network is loaded with random layout. In GUESS, run T.ayout > GEM’ and ‘Layout

> Bin Pack’ to improve layout.
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Co-Author Network of all Four NetsSci Researchers
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o Daruka, |

L
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W Tty
e

1S
x Elamminioh V
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/
[ / Node Size & Color Edge Size & Color
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; Co-Authored
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) Shce o Zcience .
o 7w Co-Author Network of all Four NetsSci Researchers

Use the GUESS Graph Modifier to change

color and size COdiﬂg. Joint Co-Authorship Network

Calculate node degrees in Sci2 ToQ,];:j;,i {

;1{.’

Use a graphic program to add legend.

M
‘ | Jmmen
f
~ , /
= R ,T A \\ f ,’I Node Size & Color Edge Size & Color
N |/ Number of |’-.||‘c.‘~ Number of Times
Co-Authored
SiDE 127
Eugene Garfield 33
35
5 1
| —
1 127 1 33

76



Individual Co-Author Networks
(Read/map 4 files separately)
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Bisoiiory Network Visualization:
Node Layout

Sreséarch & practice

Load and Clean ISI File was selected.
Loaded 361 records.

Removed 0 duplicate records.

Author names have been normalized.

361 records with unique ISI IDs are available
via Data Manager.

Extract Co-Author Network was selected.
Input Parameters:

File Format: isi

Network Analysis Toolkit (NAT) was selected.
Nodes: 247
Edges: 891

GUESS was selected.




iscAtoolfor "
J =AY

ce of Science
research & practice

i

% % Wisualization - GUESS

File Edit Lawout Script  Wiew Help

Network Visualization:
Color/Size Coding by Data Attribute Values

Vespignani, A :
=
£ Field | Yalue
g colar 125,12,17,255
S Fisced False
E hen;ht 10.0 »
= (image
=] . - » @
E |label Yespignani, & e
— |labelcalar 0,0,0,255 :
labelsize 12 : - S . -
labelvisible False: (_}‘ T . .-:.'.' o ® Node Size & Color Edge Size & Color
name niGl . g | @& Number of ':".xl CrS Number of Times
rumberofworks 101 '::: Co-Authored
ariginallabel Yespignani, & .__‘;_‘ 127
strokecalor black g * 33
shyle 2 & 35
kimescited 3811 i 1
wisihle krie i (3]
b ios R
k3 o675



Network Visualization:
Giant Component

cieTice of Science
eS@arch & practice

Weak Component Clustering was selected.
Implementer(s): Russell Duhon
Integrator(s): Russell Duhon

Input Parameters:
Number of top clusters: 10
3 clusters found, generating graphs for the top 3 clusters.

..........
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Network Visualization:
Color/Size Coding by Degree

nice of Science
n s
B reséarch & practice
&

Node Degree was selected.

Documentation:
https://nwb.slis.indiana.edu/community/?n=AnalyzeData.No
deDegree - ;
° ? o
.......... =
. ® r e
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Network Visualization:
Color/Size Coding by Betweeness Centrality

Node Betweenness Centrality was selected. g
Author(s): L. C. Freeman

Implementer(s): Santo Fortunato

Integrator(s): Santo Fortunato, Weixia Huang

Reference: Freeman, L. C. (1977). A set of measuring centrality

based on betweenness. Sociometry. 40:35-41. *

Input Parameters:
Number of bins: 10

Garfield, E -

umber of bins: 10

..........
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: Network Visualization:
3 Reduced Network After Pathfinder Network Scaling

S0 eMakeev MA fo -
"'."I:F, T . - 'gl'llﬂ, HE .
- - : -
" ®Jeong H *
- . e "
-Hmh:v, 5 . . eKang B
. g
e - . -
... L L o -
a.: L ® . L b
N . _’;ahaﬂ. AL .
. o . L .za?(
B LI TN . = OraseasormRe. sLoiaV
* L
®01va, ZN .
. spignani, &
il Tt e . S
¥ 'lVaqu.l&z. A . .
’ L
oAer, R AN AT N
— . wBarthelemy, M
. . ®Bamat, A
MST-Pathfinder Network Scaling was selected. .~ . '
* - S
Input Parameters: . ..-..‘:'d'mmn.s \
* L]

Weight Attribute measures: SIMILARITY
Edge Weight Attribute: weight

.......... 83



& & Network Visualization:

(@) "s}‘iﬁlce ofgcience
Sres&arch & practice

Circular Hierarchy Visualization

Select Co-Author Network and run Blondel Community detection:

File Data Preparation Preprocessing [Anal'_-,fsis] Modeling  Wisualization Help

E cansale Ternporal »

.......... Geospatial 2
Load and Clean IS File weas selected,
Authar(z): Micah Linnemeier

Topical 3

O i Data Manager

* 4 E' I5] Datar CUsershUser\Desktoph10-MEH-A&H-Warkshop\DWDNsciZhsample
4 H 361 Urnique IS] Records

Irmplementeris): hicah Linnemeier Metworks L
Integrator(s): Micah Linnerneier
Documentation:

https:f fnwb.slis.indiana.edufcom munityf?n=LoadData. IS oad Ar
Loaded:

CihlsershUser Desktopt 10-MEH-A&H-WarkshopDWDhscidhsample
ormetricshisthFourbletSciResearchers.isi

Metwark Analysis Toolkit (MAT)

on

MetsciResearchers.isi
& rreraed

Urweighted & Undirected k
Weighted & Undirected L
Urwveighted & Directed L
Wifeighted & Directed k

Loaded 361 records,
Rermowved 0 duplicate recards,
Authior names have been normalized.

361 records with unique ISIIDs are available wia Data Manager,

Wrote log to

CylsersiUserfppDatatLocalTemphisiduplicateremonverlogd4773522398971021

a El IS Data: CiyUserstse
4 [ 361 Unigue ISI Rec
E;', Extracted Co-£

E Author inform

Clustering Coefficient

Mearest Meighbor Degree

Strength ws Degree

Degree & Strength

Suserage Wileight ws End-point Degree
Strength Distribution

Weight Distribution

Randornize Weights

178 bt Blondel Cornmunity Detection
OC lth parameter Vahles # | Blondel Community Detection ==

This algorithm implerments Elondel's community detection

algorithrm,

Wieight ’numherufcuauthuredwurks v] ’#]
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Network Visualization:
Circular Hierarchy Visualization

Visualize resulting tile using ‘Vsualization > Networks > Circular Hierarchy’
with parameter values

¥

# | Circular Hierarchy (3w

Provides Circular Hierarchy Wisualization on the network,

Cegree of Edge Bundling 0.75

Node Strength Column | timescited -| |
Lewel 0 [blondel_community_level 0 | | ¥ |
Level 1 [blondel_community_level 1+ | | ¥ |
Lewel 2 (blondel_community_level 2 v | | ¥ |
Lewel 3 (Mo Level -| |

Edge Weight Column [numberufcuauthuredwurks v] "ﬂ']

Mode Colar Column [numberuﬁmnrks "’] "ﬂ']

Mode Caolor Range [Green to red "] "ﬂ']




Nodes that are interlinked/clustered
are spatially close to minimize the

number of edge crossings.

Node labels, e.g,,

Network Visualization:
Circular Hierarchy Visualization
—::l{i:::i::_-\

STaky

author names.

Network structure 'ﬂ/;]‘h
using edge bundling. Al

Color coded cluster —::?"iﬁ,._...

hierarchy according to
Blondel community
detection algorithm.

Note:

v

Node Color

bazed oo MUMBERCOFWORES attribate

1 a4+ a7

Header/footer info, legend, and more meaningful color coding are under development.
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Paper-Citation Network Layout

To extract the paper-citation network, select the 367 Unigue 151 Records’ table and run
‘Data Preparation > Text Files > Extract Paper Citation Network. *

The result 1s a unweighted, directed network of papers linked by citations, named
Extracted paper-citation network in the Data Manager.

Run NAT to calculate that the network has 5,342 nodes and 9,612 edges. There are
15 weakly connected components. (0 isolates)

Run ‘Analysis > Networks > Unweighted and Directed > Weak Component Clustering’ with
parameters

! n_‘ ' = -
B | Weak Campanent Clustering @ ;,Weak Cormponent Cluster of 5151 nodes
s ezl Component Cluster of 38 nodes

Creates new graphs containing the top connected components, % \eak Component Cluster of 35 nodes

'.', Wiéeak Cormponent Cluster of 27 nodes
'ﬂ' '.',', Wifeak Cormponent Cluster of 27 nodes.2
£, Weak Component Cluster of 15 nodes

Murnber of top clusters 10|

to 1dentify top-10 largest components. The largest (giant) component has 5,151 nodes.

To view the complete network, select the network and run ‘Visualization > GUES'S".
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Studying Four Major NetSci Researchers (ISI Data)

Burst Analysis for Abstracts

Run ‘Preprocessing > "Topical > 1Lowercase, Tokenize, Stem, and Stopword Text with the
‘Abstract’ box checked followed by “Analysis > Topical > Burst Detection’ with
parameters on the left and then run ‘Visualize > Temporal > Horizontal Line Graplh’
with parameters on right.

Perform Burst Detection on time-series textual daka,

aamma | 1 .I:I| |

Bursting Skates | 1 | Takes tabular data and generates PoskScript For a horizonkal bar graph.

Drate Column |F‘|.|I:u|i|:al:i-:|n Year w | m Label I'-.-'-.-'Drd j i
[Dakte Farmak | Y | Skart Dake IStart j er
Burst Length Unit |‘fears hd | m End Date IEnd j -
Burst Length | 1 | Size By IStrength j -
Text Calumn |-':'-|:'5tr-3':t "’ | m Date Format IMDnth-Day-\“ear Date Format (1.5, e.q. 10/31/2010) j i
Text Separator | | | Year Label Font Size | 20,0 2
Docurnent Calurnn |Cite Me As e | M Bar Label Font Size | 20,0 B
Ignore Input With Empey Text 2 Cancel |

Ok, Cancel



Drate: s feme of azolyes: Manch 2R, 2000 4348 PM EDT
Fegpnat chigta: Buasst detechion analyvas (Y, Referends) mmmasn Baarst kel |

Honzontal Bar Graph for mamnomm burst level 1

Label Column: Word

Start Dare Cobamee Start

End Drate Cohmmn: End

Size By Cobumoc Six 1

Drase Foonat Colusmn: Moo b=~V Diyes Foromas
Year Labe] Font Saze: 20,0

Bar Label Fonr Size: 2000

Area size equals numerical
value, e.g., award amount.

Text, e.g., title

Start date End date

Cybermbmsmasun hie Mebwork Seenes Crisvies (2000) Hemaintal Bar CGissph. Tndiana 1
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0.
&

ience of Science
S&arch & practice
&

- '.',;*u

Studying Four Major NetSci Researchers (ISI Data)

Burst Analysis Result

Wasserman S, 1986, BRIT ] MATH STAT PSY, V39, P
Wasserman S, 1987, PSYCHOMETRIKA, V52,
Wasserman S, 1985, | MATH PSYCHOL, V29, P406
Fienberg SE, 1985, ] AM STAT ASSOC, V80, P51
Wasserman S, 1984, SOC NETWORKS, Vo, P177
Holland PW, 1981, ] AM STAT ASSOC, V76, P33
Holland PW, 1983, SOC NETWORKS, V5, P109
Fienberg SE, 1981, SOCIOLOGICAL METHODO
Meyer MM, 1982, ANN STATIS, V10, P1172

Fienberg SE, 1980, ANAL CROSS CLASSIFIE
Bishop YMM, 1975, DISCRETE MULTIVARIAT
White HC, 1976, AM | SOCIOL, V81, P730

Gartield E, 1977, CURR CONTENTS, P5

1972 1973 1974 1975 1976

1977 1978 1979 1980 1981 1982 1983 1984 1985 1986
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Workshop Overview

1:00-1:15 Introduction to Network Analysis

1:15-1:45 Network Analysis & Visualization in the Humanities

. Theory, Applications, and Pitfalls.

e  Examples In The Wild

1:45-2:15 Collecting, Cleaning & Formatting Data

2:15-2:25 Break

2:25-3:00 Sci2 Tool Basics

. Macroscope Design and Usage.

. Download and run the tool.

*  Find basic statistics and run various algorithms over the network.
*  Visualize the networks as either a graph or a circular hierarchy.

3:00-3:20 Sci2 Workflow Design: Padgett's Florentine Families - Prepare, load,
analyze, and visualize family and business networks from 15th century
Florence.

3:20-3:35 Break
3:35-4:00 Sci2 Research Demonstration: Mapping the Republic of Letters

4:00-4:30 Q&A and Technical Assistance
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Workflow Design:

Padgett’s Florentine Families



Padgett's Florentine Families - Compute Basic
Network Properties & View in GUESS

> Load Myoursci2directory™/ sampledata/ socialscience/ florentine.nwb
» Run ‘Analysis > Network Analysis Toolkit (NAT)’ to get basic properties.

This graph claims to be undirected.

Nodes: 16

Isolated nodes: 1

Node attributes present: label, wealth, totalities, priorates
Edges: 27

No self loops were discovered.

No parallel edges were discovered.

Edge attributes:

Nonnumeric attributes:

Example value

marriag... T

busines...FF

Average degree: 3.375

There are 2 weakly connected components. (1 isolates)
The largest connected component consists of 15 nodes.
Did not calculate strong connectedness because this graph was not directed.
Density (disregarding weights): 0.225

» Optional: Run ‘Analysis > Unweighted & Undirected > Node
Betweenness Centrality’ with default parameters.

> Select network and run Visualization > GUESS’ to open GUESS with file loaded.

» Apply ‘Layout > GEM’.
» Open NWB File
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El consale

=101 x]

=
i 8

IUESS was selected,

uthor(s): Evtan Adar

mplementer{s): Evtan Adar {GIUESS), Russell Duhon {resizeLinear, colorize Fix)

nkegrator(s): Russell Duhon

eference: Adar, Evtan, "GUESS: A& Language and Interface for Graph Exploration," CHI 2006 (hittp:/ /graphexploration.cond.org,’}
acumentation: https://nwb.slis.indiana.edu/community /?n=vYisualizeData.GUESS

CHO is aff,

tarking GUESS. ..

CHO is off.

he initial layout For vour visualization is random, For a dearer visualization, please run a lavaut from the Lavout menu, (We recommend GEM.)
CHO is aff.

IJUE33 log File for this session can be found in

ADOCUMER 1 katyiLOCALS~14 Templ CIShell-Session-555892 StaticExecutableRunner-55904 ALGORITHM quesslog. bxt

& “W¥isualization - GUESS

uthor(sy: Evtan Adar File Edit Layout Script  Wiew  Help
mplementer(s); Evtan Ad:
nkegrator(s): Russel Dul‘lnln Medici-Acciaiuoli
eference: Adar, Evtan, = -
ocumentation: https://1| 8 Field Walue
CHO is off. g  edgeid 0
tarting GLUE3S = business F
i =
CHQ.'S. off 8 [color dandelion
he initial lawouk For wour v | 2 [
CHO is aff. B directed False
IJESS laq file For this sess | 5 [label
ADOCUME-1kabyiLoCh labelcolor 0,0,0,255
labelsize: 1z
E scheduler labelvisible False
marriage T
Remaove Fraom List | T F node! n2
nodeZ ni
III visible true
weight 1.0
| [ Blgorithm | Mot 2
GLESS
GUESS

+|| Mode Betw
| Metwork A
| Load...
| GruPlok
| GruPlot
v'| Degree Dis
| Barabasi-f
| GruPlok
~'| Degree Dis
~'| GIESS
| Load...

Chject:

| Property: Operakor:

Colour Shiow Hide Size Show Label Hide Label

L= L=

MNode Shape Zenter Change History

Interpreter |, Graph Modifier

= . MWE File: C\Dacurments and SettingsikatyiC
4/ Distribution of degree For nebwork at sty

= , List of edges of network created through the
P/ Distribution of degree For nebwork at sty
P4/ Distribution of degres For nebwark at sty

= . MWE File: C\Documents and SettingsikatyC
:—_ Graph and Metwork Analysis Log
:‘_ Sequence of site bebweennesses For noc
Pl Distribution of site betweenness For net,
P Distribution of site betweenness For neky
i . WWE File with site betweenness attribute

=101 %]

Value:

Change Label




: -¥isualization - GUESS

File  Edit  Layout

Scripk Wiew  Help

[ Information Window

Medici
Field | Yalue

color cornflo. ..
Fized Falze
height  10.0
image
label Medici
labelcolor 0,0,0,...
labelsize 12
labelvi,,. False
narnme n9

ariginal, .. Medici
priorates 53

strake... cadeth...

skyle z
kotalities 54

visible  krue
wealth 103
width 10.0

B 90.625,.,
iy 44,512, ..

P
b

00

L e

i ceveron |

Calar,..

Remaoyve

Add

Modify Field. ..
Copy as Yariable. .,

Ohiect: | '~ Property: Operator: value: | |
| Colowr || Show || Hide || Siee || Showlsbel || Hidelabel || Changelabel |
| Format Mode Labels | | Format Edge Labels |
| Modeshape || Center || Change History |
| Resielinear || Colorize |
\Nodes | [labelsize | From: | | Ta: | || Do Resiee Linear

Interpreter . Graph Mn:nu:liFierf

_|olx| Pan:

“grab” the background
by holding left-click
and moving your
mouse.

Z.0om:

Using scroll wheel,
press the “+” and “-”
buttons in the uppet-
left hand corner, or
right-click and move
the mouse left or right.
Center graph by
selecting ‘View ->
Center’.

Select @‘to
select/move single

nodes. Hold down
‘Shift’ to select
multiple.

Right click to modify
Color, etc.
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. -¥isualization - GUESS

=101

Puceis)

File  Edit  Lawouk  Scripk Misw  Help
Pucci :
E Field | Yalue J
g rcolor 758,25,
[ Fixed False
g fheiaht 5.0 3 Castellani)
= image o
E |label Pucci Barbador) Ginori)
— llabelcolor 0,0,0,... | )
labelsize 12 Lamb SfESENt) peruzzi) N Salviati)
labelvi,., true ‘i‘!‘ . Albizzi?)
narne nlz r
original. .. Pucc ) ! A Pazzi)
priorates 0 Bischeri?) Ridolfi:) N )
stroke.., cadeth... Q Guadagni) Medici:)
skyle 2 )
tokalities 1 Tornabuoniy) Acciaiuoli)
visible  true -0 :
wealth 3 m
width 5.0
X 15.0
" 91.100.., t&j
F .

Interpreter . Graph MndiFier/f

Ohject: I:E Property: Operator: Value: El

| Colour || Show || Hide || Size: || Showe Label || Hide Label || Change Label |

|| Format Node Labels ||| Format Edge Labels |

| Mode Shape || Center || Change History |

| Resize Linear || Colorize |

Graph Modifier:

Select “all nodes” in the Object
drop-down menu and click ‘Show
Label’ button.

Select ‘Resize Linear > Nodes >
totalities” drop-down menu, then
type “5” and “20” into the From”
and To” Value box separately.
Then select ‘Do Resize Lineat’.

Select ‘Colotize>
Nodes>totalities’, then select
white and enter (204,0,51) in the
pop-up color boxes on in the
“From” and “To” buttons.

Select “Format Node Labels”,
replace default text {originallabel}
with your own label in the pop-up
box ‘Enter a formatting string for
node labels.
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¥isualization - GUESS

=10 x|

“\labelcalor 0,0,0,...

File Edit Lawout Script  Wiew  Help
1 Acciaiuolii) :
z
2| Field | Yalue
g colar 758,74,
= fized false
[ :“nff;': 56635, . Castellani)
f N
E| |label Acciaiu. .. ’ Barbadar:) Ginari’)
Lamb L) Peruzzi) Salviati;)

labelsize 12
labelvi... true
nanme nl

ariginal. .. Acciaiuoli
priorakes 53
stroke,.. cadeth...

shyle Z
kotalities 2

visible  true
wealth 10

width 5.6635,..
* 112.01...
y 70.315...

BEEEREPDE 00

Fucci

Bischeri?)

=== resizeLinear{totalities,5,20)
== colorize{wealth,white,red)
=

AlbiZZi:)
Strozzis) _
Ridolfi’) Pazzi)
! Medici)
Guadagni)
Tornabuoni) Acciaiuoli)

Interpreter:
Uses Jython a combination of Java
and Python.
Try

colorize(wealth, white, red)

resizeLinear(sitebetweenness, 5, 25)

Interpreter )"' araph Ml:udil:ier/."'
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Workshop Overview

1:00-1:15 Introduction to Network Analysis

1:15-1:45 Network Analysis & Visualization in the Humanities

*  Theory, Applications, and Pitfalls.

. Examples In The Wild

1:45-2:15 Collecting, Cleaning & Formatting Data

2:15-2:25 Break

2:25-3:00 Sci2 Tool Basics

. Macroscope Design and Usage.

. Download and run the tool.

. Find basic statistics and run various algorithms over the network.
. Visualize the networks as either a graph or a circular hierarchy.

3:00-3:20 Sci2 Workflow Design: Padgett's Florentine Families - Prepare, load,
analyze, and visualize family and business networks from 15th century
Florence.

3:20-3:35 Break
3:35-4:00 Sci2 Research Demonstration: Mapping the Republic of Letters

4:00-4:30 Q&A and Technical Assistance
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Workshop Overview

1:00-1:15 Introduction to Network Analysis

1:15-1:45 Network Analysis & Visualization in the Humanities

*  Theory, Applications, and Pitfalls.

. Examples In The Wild

1:45-2:15 Collecting, Cleaning & Formatting Data

2:15-2:25 Break

2:25-3:00 Sci2 Tool Basics

. Macroscope Design and Usage.

. Download and run the tool.

. Find basic statistics and run various algorithms over the network.
. Visualize the networks as either a graph or a circular hierarchy.

3:00-3:20 Sci2 Workflow Design: Padgett's Florentine Families - Prepare, load,
analyze, and visualize family and business networks from 15th century
Florence.

3:20-3:35 Break
3:35-4:00 Sci2 Research Demonstration: Mapping the Republic of Letters

4:00-4:30 Q&A and Technical Assistance
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Sci2 Research Demonstration:
Mapping the Republic of Letters



Mapping the Republic of Letters

» Load Sample Data/ samplel ettersNetworke.nwb
» Run ‘Analysis > Network Analysis Toolkit (NAT)’ to get basic properties.

This graph claims to be directed.

Nodes: 9

Isolated nodes: 0

Node attributes present: label, totaldegree
Edges: 15

No self loops were discovered.

No parallel edges were discovered.

Edge attributes:

Did not detect any nonnumeric attributes.

Select Analysis > Networks > Unweighted & Directed > Node Betweenness Centrality with
‘weight’ for Weight Attribute

Select Analysis > Networks > Unweighted & Directed > Adjacency Transitivity

Select Analysis > Networks > Unweighted & Directed > Dyad Reciprocity

Select network and run Visualization > GUESS’ to open GUESS with file loaded.
Apply ‘Layout > GEM’.

Export / Import Node Positions — notice that full network is needed before doing
this

VVVYVYYVY V:
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i

JA'tool for/ Jin =l
&lce of!cience

Mapping the Republic of Letters

» Load Sample Data/ CEN1640.nwb, Sample Data/ CEN1641.nwb, and Sanple
Data/ CENT642.nwb

» Run ‘Analysis > Network Analysis Toolkit (NAT)’ to get basic properties.
Nodes: 868

Isolated nodes: 0

Edges: 898

No self loops were discovered.

No parallel edges were discovered.

Average total degree: 2.0691

Average in degree: 1.0346

Average out degree: 1.0346

This graph is not weakly connected.

There are 95 weakly connected components. (0 isolates)
The largest connected component consists of 607 nodes.
This graph is not strongly connected.

> Select network and run Visualization > GUESS’ to open GUESS with file loaded.
» Apply ‘Layout > GEM’.

» Export / Import Node Positions — notice that full network is needed before doing
this
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Workshop Overview

1:00-1:15 Introduction to Network Analysis

1:15-1:45 Network Analysis & Visualization in the Humanities

*  Theory, Applications, and Pitfalls.

. Examples In The Wild

1:45-2:15 Collecting, Cleaning & Formatting Data

2:15-2:25 Break

2:25-3:00 Sci2 Tool Basics

. Macroscope Design and Usage.

. Download and run the tool.

. Find basic statistics and run various algorithms over the network.
. Visualize the networks as either a graph or a circular hierarchy.

3:00-3:20 Sci2 Workflow Design: Padgett's Florentine Families - Prepare, load,
analyze, and visualize family and business networks from 15th century
Florence.

3:20-3:35 Break

3:35-4:00 Sci2 Research Demonstration: Mapping the Republic of Letters

4:00-4:30 Q&A and Technical Assistance
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° : Possible Workflows

» Geographic Visualizations
» Word Co-Occurrence Analysis

> Your Data
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Extraneous Slides

Adding Plugins to CIShell Powered Tools
OSGi/CIShell Adoption
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g:g C I Cyberlnfrastructure Shell (CIShell)
{2 http://cishell.org

» CIShell is an open source software specification for the integration and utilization of
datasets, algorithms, and tools.

» It extends the Open Services Gateway Initiative (OSGi) (http://www.osgi.org), a
standardized, component oriented, computing environment for networked services

widely used in industry since 10 years.

» Specifically, CIShell provides “sockets” into which existing and new datasets,
algorithms, and tools can be plugged using a wizard-driven process.

Developers

Alliance NN% Iﬂje}j%l[e
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http://cishell.org/
http://images.google.co.uk/imgres?imgurl=http://lazytoad.com/teamtoad/season3/fb-team.JPG&imgrefurl=http://lazytoad.com/teamtoad/team.html&h=640&w=480&sz=42&hl=en&start=4&tbnid=ys_paPY27oI4EM:&tbnh=137&tbnw=103&prev=/images%3Fq%3Dteam%26svnum%3D10%26hl%3Den%26lr%3D%26sa%3DG
http://images.google.co.uk/imgres?imgurl=http://www.unlimitedperformance.org/pics/staff.jpg&imgrefurl=http://www.unlimitedperformance.org/ourteam.html&h=339&w=375&sz=38&hl=en&start=91&tbnid=TqFMu6iVekzTwM:&tbnh=110&tbnw=122&prev=/images%3Fq%3Dteam%2Bmedicine%26start%3D80%26ndsp%3D20%26svnum%3D10%26hl%3Den%26lr%3D%26sa%3DN
http://images.google.co.uk/imgres?imgurl=http://www.heartscan.com.my/images/Team.gif&imgrefurl=http://www.heartscan.com.my/services.htm&h=275&w=420&sz=49&hl=en&start=48&tbnid=YSu4GxdZAsrPoM:&tbnh=82&tbnw=125&prev=/images%3Fq%3Dteam%2Bmedicine%26start%3D40%26ndsp%3D20%26svnum%3D10%26hl%3Den%26lr%3D%26sa%3DN
http://images.google.co.uk/imgres?imgurl=http://lazytoad.com/teamtoad/season3/fb-team.JPG&imgrefurl=http://lazytoad.com/teamtoad/team.html&h=640&w=480&sz=42&hl=en&start=4&tbnid=ys_paPY27oI4EM:&tbnh=137&tbnw=103&prev=/images%3Fq%3Dteam%26svnum%3D10%26hl%3Den%26lr%3D%26sa%3DG
http://images.google.co.uk/imgres?imgurl=http://www.unlimitedperformance.org/pics/staff.jpg&imgrefurl=http://www.unlimitedperformance.org/ourteam.html&h=339&w=375&sz=38&hl=en&start=91&tbnid=TqFMu6iVekzTwM:&tbnh=110&tbnw=122&prev=/images%3Fq%3Dteam%2Bmedicine%26start%3D80%26ndsp%3D20%26svnum%3D10%26hl%3Den%26lr%3D%26sa%3DN
http://images.google.co.uk/imgres?imgurl=http://www.heartscan.com.my/images/Team.gif&imgrefurl=http://www.heartscan.com.my/services.htm&h=275&w=420&sz=49&hl=en&start=48&tbnid=YSu4GxdZAsrPoM:&tbnh=82&tbnw=125&prev=/images%3Fq%3Dteam%2Bmedicine%26start%3D40%26ndsp%3D20%26svnum%3D10%26hl%3Den%26lr%3D%26sa%3DN
http://www.osgi.org/

-‘O\
OgC l CIShell — Builds on OSGi Industry Standard

CIShell 1s built upon the Open Services Gateway Initiative (OSGt) Framework.

OSGi (http://www.osgi.org) is
» A standardized, component oriented, computing environment for networked services.

» Successfully used in the industry from high-end servers to embedded mobile devices
since 8 years.

» Alliance members include IBM (Eclipse), Sun, Intel, Oracle, Motorola, NEC and many
others.

» Widely adopted in open soutce realm, especially since Eclipse 3.0 that uses OSGi R4
for its plugin model.

Advantages of Using OSGi

» Any CIShell algorithm is a service that can be used in any OSGi-framework based
system.

» Using OSGi, running CIShells/tools can connected via RPC/RMI supporting peet-to-
peer sharing of data, algorithms, and computing power.

Ideally, CIShell becomes a standard for creating OSGi Services for algorithms.
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QoaC I CIShell — Converter Graph

YV V V

No central data format.
Sci? Tool has 26 external and internal data formats and 35 converters.

Their relationships can be derived by running ‘File > Converter Graph’ and
plotted as shown here. Note that some conversions are symmetrical (double

arrow) while others are one-directional (arrow).
@ file text/edge

@ file textinwh
@ file:text'treeml+xml @ db:nsf

®prefuse data Tree @ file:text/graphmi+xmi
@ file:application/pajeknet
® prefuse data. Graph @ db:any

@file: lication/pajekmat
@ edu.uci.ics. jung.graph.Graph eAppleaiaRAE
@ edu berkeley guir.prefuse. graph.Graph @dbisi Ffiletextipg

@ file:text/=gmml+xml

@ java.awtimage Bufferedimage

@filetext'scopus

@ filetext'bibtex
@ filetext/grace ® file:text/ps
@ file:textplat @ file text/isi
®prefuse data Table
@fileitexticav
@ filetext/insf

@ file:text/ireferbib 109



QGQC I CIShell — Add new Plugins, e.g., UCSD Science Map

» Notall code can be shared freely (yet).

» 'To make the UCSD Science Map and new geomaps available via the Sci? menu,

simply add

wrnerkiDeskiopiMIH-1 24 sciz2-plugins V| !
Mame & Size  Type Date Modified

edu.iu.scipolicy . visualization.geomaps_0.0.1.jar 4,864 KB Executable Jar File 6/24/2010 5:41 PM

edu.iu,scipolicy, visualization. scimaps_0.0.1.jar 1,507 KB Executable Jar File 6/18/2010 317 PM

arg,cishell.reference, qui,persistence_1.0.0.jar 61 KB Executable lar File af24z010 541 PM

org.cishell utilities_1.0.0.jar 72KB Executable Jar File 6242010 5:41 PM

to the ‘yourdirectory/ plugin’ directory and restart the tool.

The files were made

avatlable in
/ sci2-plugins directory

on the computers in the
tutorial room.

The rights to the UCSD map are owned by the Regents of UCSD. Usage does not require
a separate, signed agreement or an additional request to our office if consistent with the
permission. As a courtesy, please send information on how the map is being used to
William J. Decker, Ph.D.; Associate Director, Technology Transfer Office
Unitversity of California, San Diego, 9500 Gilman Drive Dept. 0910, La Jolla, CA 92093

phone:858-822-5128, fax: 858-534-7345, e-mail: widecker(@ucsd.edu

» To delete algorithms that you do not use, simply delete the corresponding *.jar files in

the plugin directory.

» Customize your menu structure accordingly—see next slide.
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CIShell — Add new Plugins, e.g., UCSD Science Map

> After you added the new plugins, load an ISI file using ‘File > TL.oad and Clean ISI File

> BugeneGartield.is1.”

The file can be found in the /sampledata/ scientometrics/ isi directory.
> Select ‘99 Unique ISI Records’ file in Data Manger and run “Visualization > Topical >

Science Map via Journals’ with parameters:

M Science Map via Journals @

Locate the journals from a kable on the LCS0 Map of Science
T el Journal Name (Abbreviated) v
Suallg iy 1.0
Dataset display name | EugeneGarfield.isi
(
» 'The result is a science map ‘ \\J(
overlay of Garfield’s papers 258 &l ——eg s
and a listing of journals in |\ 03’° '
13 fields of science below. = b
See details in Tutorial #6. G4 i
(\_//' Wi “. ‘
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%8(9 C l CIShell — Customize Menu

» The file Yourtooldirectory/ configuration/ default_menn.>m!’ encodes the structure of
the menu system.

» In NWB Tool, the Modeling menu (left) is encoded by the following piece of
xml code:

@ Metwark Workbench Toal

File Preprocessing | Modeling | Analysis  Visualization  Scientometrics

El Consale

INE MNETWOTK WOrkDE
investigators are Dr. K
Wifasserrman, and Dr, §

Random Graph
Wiatts-Strogatz Small World
Barabasi-&lbert Scale-Free

l

e ]

Sch

The MWE tool was de Cere n,

Tank, loseph Bibersti Chord fuCH

Terkhorm,Heng Zhan Hynerarid nen

Wespignani, and Katy YRer

PRU
Metwork Workbench g d
Science Center (hitpy TARL .
; : <top_menu name="ModeTing" >

Please cite as follows Discrete Metwork Dynarmics (O <menu FI'I d="edu.du. ﬂWb.deE-l:lﬂg. erdusr‘andumgr‘aph";’:}

MW Team. (2006). N zmenu pid="edu. fu. nwb.modaTing. smallwor1d" /=

hitp:finwhb.slis.india Evolving Metwork (Weighted) a] M Lo . . g. . "
<menu pid="edu.iu. nwh.modeling. barabasialbert" >
<menu Type="break" />
<menu pid="edu.iu.iv.modeling. p2p. can.Canalgorithm” >
<menu pid="edu.ju.iv.modeling. p2p. chord. Chordalgorithm” />
<menu pid="edu.id. iv.modeling. p2p. hypergrid. Hypergrid"~
<menu pid="edu.iu. iv.modeling. p2p.pru. Prualgorithm” =
<menu type="break"/ />
«menu pid="edu.iu. iv.modeling. tarl.Tarlalgorithm" />
<menu Type="break"/ /> . . . )
<menu pid="edu.iu. nwh.modeling. discretenetworkdynamics. DDAl gorithm" />
<menu type=”break”f>
zmenu pid="edu.iu. nwh.modeling. weighted. evolvingnetwork" /=

< /Top_menus
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CIShell - Integrate New Algorithms

Algorithm Developer's Guide

Overview

The Cyberinfrastructure Shell {CIShelly is an apen source, community-driven platfarm
far the integration and utilization of datasets, algorithms, taols, and computing
resources, Algarithm integration support is built in for Java and most other programming
languages. Being Java based, it will run on almost all platforms. The software and
specification is released under an Apache 2.0 License,

This guide attempts to aid algorithm developers in creating algorithms for CIShell (and
applications built on CIShell}.

This guide tries to contain all the information a new dewvelaper needs, but where
necessary, it may cite the CIShell 1.0 Specification (API) ar the 05GI Service Platform
Specification, Release 4 {API). While the guide tries to make beginning algorithm
development easier, the CIShell Specification has the last word on how the CIShell
Platform works.

Table of Contents

1. CIShell Basics
2. Getting Started
Tutorial 0: Setting Up the Development Environment
Tutorial 1: Creating a Hello \Waorld Jawva Algaorithm
Tutorial 2: Practical Java Algorithm Development
Tutorial 3: Integrating a Mon-Java Program &= An Algorithm
Mini-Tutorial: Integrating 3rd-party libraries
Where to Learn More
3. Reference
1, How algorithims Work: & guide to algorithm plugins in CIShell
2, Accessing the 05Gi Console in CIShell tools

[T [ N T T e Y

http:/ [ cishell.org/ Zn=DevGuide. NewGuide
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OSGi/CIShell Adoption
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CIShell/OSGi is at the core of different Cls and a total of 169 unique plugins are used in the
- Information Visualization (http://iv.slis.indiana.edu),

- Network Science (NWB Tool) (http://nwb.slis.indiana.edu),

- Scientometrics and Science Policy (ScF Tool) (http://sci.slis.indiana.edu), and

- Epidemics (http://epic.slis.indiana.edu) research communities.

Most interestingly, a number of other projects recently adopted OSGi and one adopted CIShell:

Cytoscape (http:/ /www.cvtoscape.org) lead by Trey Ideker, UCSD is an open source bioinformatics
software platform for visualizing molecular interaction networks and integrating these interactions
with gene expression profiles and other state data (Shannon et al.; 2002).

Taverna Workbench (http://taverna.sourceforge.net) lead by Carol Goble, University of Manchester,
UK 1s a free software tool for designing and executing workflows (Hull et al., 20006). Taverna allows
users to integrate many different software tools, including over 30,000 web services.

MAEviz (https:/ /wiki.ncsa.uiuc.edu/display/MAF/Home) managed by Shawn Hampton, NCSA is an
open-source, extensible software platform which supports seismic risk assessment based on the Mid-
America Earthquake (MAE) Center research.

TEXTrend (http://www.textrend.org) lead by George Kampis, E6tvos University, Hungary develops a
framework for the easy and flexible integration, configuration, and extension of plugin-based
components in suppotrt of natural language processing (NLP), classification/mining, and graph
algorithms for the analysis of business and governmental text corpuses with an inherently temporal
component.

As the functionality of OSGi-based software frameworks improves and the number and diversity of
dataset and algorithm plugins increases, the capabilities of custom tools will expand.



http://iv.slis.indiana.edu/
http://nwb.slis.indiana.edu/
http://sci.slis.indiana.edu/
http://epic.slis.indiana.edu/
http://www.cytoscape.org/
http://taverna.sourceforge.net/
https://wiki.ncsa.uiuc.edu/display/MAE/Home
http://www.textrend.org/

@ @ The Changing Scientific Landscape

Star Scientist -> Research Teams might have 100 or more members & exist few months only.
Users -> Contributors students, faculty, practitioners.
Disciplinary -> Cross-disciplinary with different cultures, languages, approaches.
One Specimen -> Data Streams updated nightly or even more frequently

High Quality Open Data

Scholarly Database: 23 million scholarly records
@ http://sdb.slis.indiana.edu

S VIVO National Researcher Networking
%@3’1 http://vivoweb.org
Static Instrument -> Evolving Cyberinfrastructure (CI) daily learning and documentation.

Macroscopes can make a major difference if they support:

Division of Labor — proper incentive structures are key.

Ease of Use — learn from YouTube, Flickr, Wikipedia

Modularity — plug-and-play helps reduce costs; increases flexibility, augmentation, customization
Standardization — speeds up ‘translation’ into products/practice.

Open Data and Open Code — use the minds of millions!


http://sdb.slis.indiana.edu/
http://vivoweb.org/

Epidemics Marketplace

g@ EpiC

Categories

Demographics
Infectious Diseases
Zocial Contagion
Transportation
Uncategorized

1255 § 1918 ace § Adelo §
aida § aidine é Echaner é bedily é
mmoodo § e { doiokoa §
Dexegrophic.. é deegrophie.. é
lomihc § fomaly § Migh § ﬂu§
Muida § Frun ood '!'__.. § Fe=grophy §
rech § hiealth £ Hehb o §
bir§ HIV § Homeowoosh .. §
Heumog Woe.. § iTLCOINE
wfooule § ofuman § iarooe §

§ Obeaiy} Pondeme
Poymenl de.. § Felicaydn .. § )
repieanl § amacanl § Stnoking

spanish Taird { Tobees liac £
travel_é .5, § Tnited
Stat.. ! uma § wedd 3 jorly |

Browse

Upload

| Request | About

The EpiC Marketplace

community I«

@ Browse

View & Download
projects, datasets,
and requests, by
category and tags

Location of datasets

srowse, request, and share epidemics !uhl Learn More >>

®Upload

Upload your
datasets or create
a project with
multiple datasets

(?)Request

Can't find a dataset
you're looking for?
Make a Request!

bttp:/ [ dev.epic.slis.indiana.edn

(v) My Account

Recent Activity
Data Requests

Need Health Insurance
coverage data. - Micah
Linnemeier - Indiana
University Doesanyone
have daca an heakh inssmnce
caverage gy family incame kvell
Thanks.

acammencs,

HIY/AIDS - Jim Sherman
Mewd daca an HTV.
Q commencs.

Data Uploads

Housing Yacancies and
Homeownership Subset
of 2008 - Jim Sherman
The Housing Vacancksand
Homeownership pravides currenc
infarmacian an che rencaland

hameawner vacancy @ees, ...
Q commencs.

Behavioral Risk Factor
Surveillance System - Jim
Sherman

BRFSS: Turning Tnfarmacion inca
Heakh The BEehaviorm | R&k Faccar
Surwilbnce Sysem (ERPSS) mche
workd's ...

Qcommencs.



http://dev.epic.slis.indiana.edu/

cyberinfrastructure for
ETWORK SCIENCE CENTER

Schiool of Library and Information Science | Indiana University Bloomington

N JLe
Events

Cyberinfrastructures Teaching Outreach

All papers, maps, cyberinfrastructures, talks, press are linked
from http://cns.slis.indiana.edu
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